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Introduction to Arduino, Breadboard and Resistors

You should have received two kits: Arduino starter kit and an extra lab kit. In lab 1 we’ll be
mostly using the contents of Arduino kit, and only one component from the extra lab kit.

Arduino starter kit Extra lab kit

1 Arduino

Arduino is an open-source electronics platform that allows easy and rapid development
of projects, ranging from hobby electronics to actual devices including biomedical instru-
ments. At the heart of Arduino is a programmable microcontroller which acts as a tiny
computer capable of running custom software. This software lets us monitor and control
electronics that are connected to the Arduino board. Before getting started with Arduino,
we have to download the appropriate software. Go to the following link and download
Arduino IDE: www.arduino.cc/en/Main/Software
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Open up your Arduino kit and remove the Arduino board and USB cable from their
boxes, then, connect them together and into the USB port of your computer.

Now, launch the Arduino software you installed earlier and wait out the loading screen.
You should be directly taken to a screen that looks like the picture below. This is the tem-
plate code for an empty software. Although it might not look like much, but this screen
provides you with almost infinite possibilities! Here you can write code for programs as
simple as blinking LEDs, timed traffic lights, or even Al-based prediction of stroke in a
wearable ECG device! These programs are written in the C++ language, which is a pow-
erful language which most operating systems (including Windows, macOS and Linux) are
written in.

&8 sketch_may22a | Arduina 1.8.12 — 0 P4
File Edit Sketch Tools Help

sketch_may22a

void setup() { ~
[/ put your setup code here, to run once:

1

void loop() {
/f put vour main code here, to run repeatedly:

1
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Normally in lab we would have access to equip-
ment such as multimeter or oscilloscope to help us
with electrical measurements. However, for our at-
home labs we are going to write a simple but very
useful program to turn Arduino into an oscilloscope,
with only 3 lines of code! The picture on right shows
the code that you have to write. Pay extra attention
to character cases because C++ is a case-sensitive
language. Lines starting with two forward slashes
(//) are not a part of the program, they are just com-
ment lines that describe what the following portion
of code is doing. Feel free to skip them in your own
code. If interested, you may want to take a look over
an in depth tutorial on Arduino oscilloscope. Save
your project with an appropriate name.

€9 VoltMeter | Arduino 1.8.12
File Edit Sketch Tools Help

20 BEHA
Yoltheter

void setup({) {
// Initialize serial communication
Serial.begin{9600);

1

void loop({) {
// Read analog value and convert it to units of mV
=ad (R0} / 1023. * 5000;

int val = ana

// Send ocut the read wvalue over serial port to PBC
Serial.println(val);

}

Before uploading the oscilloscope program onto Arduino, we need to let the software
know what kind of Arduino we are using and which port is it connected to. Open the
Tools menu and try to find “Arduino Uno” under the Board submenu. Then, open the Port
submenu and select the COM port that has written “Arduino Uno” in front of it.
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Burn Bootloader
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From the Sketch menu select Upload to transfer the program to the Arduino board. After
about a few seconds you should see a message at the bottom saying “Done uploading”. If
instead you are given an error, first make sure Arduino is properly connected to your com-
puter via the USB cable, and that the software is correctly recognizing it (look for “Arduino
Uno on COMS5” or another port number at the bottom right). Also double check your code
for any small mistakes, remember in the C++ language every character is important!
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Serial.printin(val)s
}

Export compiled Binary  Ctrl+Alt+S.

Send ocut the read value over serial port to BC

File Edit Sketch Tools Help

ift+U

/4 Send out the read value over serial port to BC
serial.println(val);
1

To test our freshly programmed oscilloscope, open Serial Monitor under the Tools menu,
and on the bottom right of the opened window select “9600 baud” from the drop-down list.
If things work as they should, you'd see a bunch of seemingly random numbers that keep
changing quickly. These numbers are the voltage that Arduino is measuring at pin AO in
units of millivolts. Since AO is not connected to anything at the moment, these numbers
mostly show the bias voltage of the internal circuitry (what?!) plus the electrical noise of

the environment.

& VoltMeter | Arduino 1812 — m] x
File Edit Sketch Tools Help
oo i Auto Format Ctrl+T
Archive Sketch O <
Voltister Fix Encoding & Reload
Manage Libraries.. Ctrl+Shift+| 1 Send
Serial Menitor Ctrl+Shift+M "
Serial Plotter Ctrl+Shift-L 3
756
WiFi101 / WiFiNINA Firmware Updater 756
756
Board: "Arduine Una" > s
756
Port: "COMS (Arduino Uno)” > 751
4 Get Board Info 751
Serial.prin 751
1 Programmer: "AVRISP mkll” > et
756
Burn Bootloader cee
756
756
76
v
Autoscroll [] Show timestamp Mewline ~ | 9600 baud ~ Clear output

1.1. Now we are ready to take some measurements! Take out some jumper wires either
from the Arduino kit (in the Breadboard and Jumper Wires box) or from the extra lab
kit. The wires look different but they serve the same purpose. Note that the color
of the wires do not matter, they all conduct electricity the same way. However, it is
always a good idea to follow the conventional color code for GND being black or blue,

and Vcc (+5v)

being red. Use one of the wires to connect GND to AO.
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What value does Serial Monitor show when AQ is connected to GND? What is the
unit for this value? Snap a screenshot of Serial Monitor for you report.

1.2. To further verify how well our oscilloscope is working, first connect A0 to the 5V pin,
and then connect it to the 3.3V pin. When voltage measurements on Serial Monitor
are changing quickly, since the values are relatively close to each other, reading any
of them would suffice.
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What value does Serial Monitor show when AO is connected to 5V and 3.3V? Snap
screenshots of Serial Monitor for you report.

1.3. So far we have seen Arduino act mostly as a multimeter for reading voltages. For
seeing an actual live plot of the readings like an oscilloscope, close Serial Monitor
and instead open Serial Plotter from the Tools menu. Remember to select “9600
baud” from the drop-down list on the bottom left corner.

OO0 B
VoltMeter

void setup()
// Initiali
Serial .begi)

}

void loop() {
// Read ana
int val = &

// Send out
Serial .prin

1
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Arduino Uno on COMS

Snap a screenshot of Serial Plotter when A0 is connected to 3.3V.

We won't be using Serial Plotter anymore in lab 1 since we will mostly be dealing
with constant voltages. In lab 2 we take full advantage of Serial Plotter for observing
time-varying voltages of RC circuits.

2 Resistors

In this section we will verify our knowledge of resistors by using the color code to read
theoretical resistance values, and come up with a simple circuit to calculate the actual
resistance value without a multimeter. If you happen to have a multimeter at home, or
would like to invest in one, | encourage you to verify all measurements with it and write
them in your report. Doing so is optional.
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4-Band-Code
2%, 5%, 10% 560k Q +5%
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0.1%, 0.25%, 0.5%, 1% 2370 +1%

5-Band-Code

2.1. Open up the Electronic Components box from your Arduino kit and take out the re-
sistor strip shown in the picture above. Use the resistor color table to find a 1£€2 and
a 4.7k resistor.

Write down the band colors for a 152 and a 4.7k resistor, and snap a photo of the
two resistors you found for the report.

2.2. Try reading the tolerance for both resistors.

What color is the last band? What is the tolerance percentage? In what range should
the actual resistance value for each resistor fall?

2.3. To verify our theoretical resistance readings we are going to use a voltage divider
circuit. Take out a breadboard either from the Arduino kit or the extra lab kit. Place
the two resistors on breadboard in series as shown in the picture.
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2.4.

2.5.

2.6.

2.7.

Make sure to push the resistors all the way into the breadboard so that they are not
loose and make perfect electrical contact, and pay extra attention to put the 1k
resistor on the left side and 4.7k<) on the right. Using three jumper wires, connect the
left pin of the 1k resistor to GND, the right ping of the 4.7k resistor to 5V, and the
middle pins to AO. Use the picture in the previous page as your guide.

Draw the full circuit diagram of what you have assembled. Label nodes as GND, 5V
and A0, and designate resistors with their values.

Hint: the two resistors are in series and this is a voltage division circuit.

Theoretically, what should the voltage of the middle pin of the resistors be?

Write the voltage division formula and calculate the theoretical voltage of A0, assum-
ing resistor values are exactly 1k€2 and 4.7k().

Read the actual voltage of A0 from Serial Monitor.

What is the actual voltage of A0? Is the actual voltage the same as the theoretical
voltage? If not, what are the reasons for this discrepancy? Name two.

Assuming the value of the 4.7k is unknown (let’s call it R;), the actual value of the
1K€ resistor is the same as its theoretical value (R;), and by knowing the voltage of
A0 from the previous section (V4g), calculate the actual value of the R;.

Rearrange the voltage division formula so that only R is on the left side of the equa-
tion and and all other terms are on the right side. Then replace the terms with their
values (R; = 1k, V.. = 5V and V) to obtain the actual resistance of R,. Is this
value similar to its theoretical value?

Using the resistor color table, find a 560¢2 resistor from the resistor strip, replace it
with the 4.7k resistor and repeat steps 2.4 to 2.6.

What is the theoretical and actual voltage of A0 when using a 560¢2 resistor? What is
the actual resistance of R, using the voltage division formula?

Congratulations! You have reinvented the multimeter! This technique is similar to the
process that actual multimeters use for measuring resistances, although for better accuracy
we would need a 1£(2 resistor with very little tolerance.
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3 Series Resistance

Grab another 560¢2 resistor and put it in series with the previous one. On the breadboard
you would have 3 resistors in series: 1k(2, the first 56062 and the second 56012. Connect
GND to the left pin of 12, 5V to the right pin of the second 56052, and A0 to the common
pin between 1£2 and the first 560€2. Use this picture as your guide.

3.1. Theoretically, what would be the equivalent resistance of two 560¢2 in series?

3.2. Using the voltage division formula, what is the theoretical voltage of A0?

3.3. What is the actual voltage reading of AO from Serial Monitor?

3.4. What is the actual equivalent resistance of the two 560 in series? Calculate using
the same technique as step 2.6.

3.5. Using our Arduino multimeter/oscilloscope, so far we've been able to measure volt-
ages and calculate resistances. But how about currents? There is a nifty technique
that’s often used in electronics for converting currents to voltages, which is simply
using our old friend the Ohms law! This is usually done with a relatively small resistor

9
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3.6.

4

that minimally interferes with the circuit’s function. Using the resistor color table find
out what color should the bands be for a 102 resistor. You should be able to find one
somewhere in the extra lab kit. Then, replace it with the 1£Q2 on your breadboard as
shown in the picture.

Assuming the 1092 has minimal impact on the circuit, meaning the two 56052 resis-
tors are directly connected to 5V, how much current should theoretically flow through
them?

By having A0 connected to the right pin of the 101 resistor, we are able to read the
voltage across it on the Serial Monitor. This tiny voltage (probably just a few millivolts)
is the result of the current that passes through the resistor, and their values are linked
by the Ohms law. Since all resistors are in series, this current is the same as the
current that flows through each of the two 56052 resistors.

Using Ohms law and the voltage of A0, calculate how much current is flowing through
the 1092 resistor? Pay extra attention to the units. Compare this two your theoretical
value from the previous step. If they are different, name two reasons why.

Parallel Resistors

In the final section of this lab we’ll be verifying our knowledge of parallel resistors and their
equivalent resistance. Grab two 4.7k€) and one 56052 resistors and put them in parallel on

10
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the breadboard. Then, take a 1kf2 resistor and put it in series with all the rest. Connect the
two ends of your gigantic resistor network to GND and 5V, and connect the middle junction
to AO. Your circuit should look like the picture below.

4.1. Draw the circuit diagram of what you have assembled on breadboard. Label GND,
5V, A0 and designate all resistors with their values.

4.2. Theoretically, what would be the equivalent resistance of the two 4.7k and one 5602
resistors in parallel?

4.3. Using the voltage division formula, what is the theoretical voltage of A0?

4.4. What is the actual voltage reading of A0 from Serial Monitor?

4.5. What is the actual equivalent resistance of the two 4.7k€) and one 56052 resistors in
parallel? Calculate using the same technique as step 2.6.

4.6. To measure the overall current that flows through all of our parallel resistors, replace
the 1k with the 10Q2 on your breadboard, similar to step 3.5.

11
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4.7.

4.8.

Assuming the 102 has minimal impact on the circuit, meaning the three parallel resis-
tors are directly connected to 5V, how much current should theoretically flow through
them?

Using Ohms law and the voltage of A0, calculate how much current is flowing through
the 1092 resistor? Pay extra attention to the units.

The circuit in the next page shows how to measure the current that flows only through
the 560¢2 resistor. This step is optional, performing and writing the results in your
report has bonus points!

BONUS: Snap a photo of what you have assembled on breadboard and draw the
circuit diagram of it. Theoretically, how much current should flow through the 5602
resistor? Based on the voltage reading from A0, how much current is actually flowing
through it? Briefly describe how the circuit works.
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